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NEXT MONTH
• We learn how to integrate Evolution 

into a heterogeneous mail server 
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• TUX reviews CrossOver Office and 

some new hardware in the Acer 3620 

laptop and the Linux Loft Edubuntu PC.
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I don’t mean to get geeky on you here, but I have
been working with some other people on a project
recently—probably working too much. But, these
recent experiences offer another example of how
Linux and open-source software fit in well with other
computing platforms. They also help show what
tools really are available to get your job done.

First, the project involves multiple people with 
different levels of computer experience. Although
the Web and other servers and many of the desktop
systems involved in the work are running Linux, they
are not all running the same version of Linux, and
there also are Microsoft and Mac desktops involved.

The project involves people spread over many
locations on the planet and over many time zones,
which basically means the only practical communica-
tion methods are e-mail and occasionally on-line
chat. We use both. There’s nothing special about the
e-mail other than an assortment of e-mail clients are
being used on an assortment of different systems.

For chat, we selected Jabber, which is a plat-
form-independent protocol that handles instant

messages, chat rooms and a lot more. We run
our own secure server for this, but if encryption
isn’t needed, public servers are available. We are
using various clients, the program that you run
on your desktop system, but the protocol is well
defined and a published standard, so everything
communicates with no problems.

For project organization, we use a wiki. If you
are not familiar with a wiki, take a look at
http://en.wikipedia.org/wiki/Wiki. Besides offering
a good definition, the Wikipedia site itself is pos-
sibly the largest example of what a wiki is. Many
versions of wiki software are available. Most of
them are free. We have used both MoinMoin
(http://moinmoin.wikiwikiweb.de) and DokuWiki
(wiki.splitbrain.org/wiki:dokuwiki).

A wiki offers remote access to information pages
using a Web browser. You can modify those pages
remotely from within your browser, making it easy to
learn quickly. Depending on which wiki you choose,
you may get image storage, access control facilities
and a lot more. In any case, it is a handy tool for
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developing and updating documentation.
Our project involves storage of data in

a database. Again, open-source software
offers some good choices. The two most
popular high-end database systems of
the Open Source world are PostgreSQL
(http://www.postgresql.org) and MySQL
(http://www.mysql.com). People will
debate which is “better”, but the reality
is that both are very complete and power-
ful database management systems.
Although we picked PostgreSQL for a
number of reasons, including more
recent experience with it, either could
do the task at hand.

The development project is a Web
application. Although the most popular
language for developing Web applications
is PHP, it seldom is the best. I don’t mean
to pick on PHP here, but it has “evolved”
a bit too much, and you will find many
applications that either are poorly
designed or poorly implemented.

On the other hand, Web development
in both Python and Ruby tend to be better
designed, and these languages encourage
better design. Specifically, each language
enables (excuse the the geek buzzword)
object-oriented programming. Each of
these languages also offers a nice develop-
ment framework (and others not nearly as
nice). For Python, that framework is called
Django (http://www.djangoproject.com),

and for Ruby, it is called Rails
(http://www.rubyonrails.org).

So, what is a development frame-
work? It is essentially a set of programs
that help you build the basic structure of
a Web site with little work. The common
word here, a word from construction, is
that they build the scaffolding. This gives
you a working, but far from optimal,
application very quickly. This application
scaffold is produced in such a way that it
is easy to modify it to create the produc-
tion version. For example, the generated
Web pages may be functionally correct
but not attractive. However, the structure
is such that you need to modify only one
thing (a template) to change the appear-
ance of all the generated pages.

Although we haven’t started writing
the actual application yet, we likely will
use Rails rather than Django, and, thus,
the application itself will be written in
Ruby. But, along the way, we have used
both Ruby and Python as languages to
test concepts. Like Linux and many open-
source projects, both languages work well
with each other. That means, for exam-
ple, that a program in one language can
store data in a PostgreSQL database, and
a program in the other could extract data
to produce reports.

Along the way, we will need to pro-
duce graphic images for Web pages, spell-

check our work and perform the tens, if
not hundreds, of other tasks we have all
come to rely on computers to do for us.
We most certainly will use Linux and
open-source tools for all the tasks.

My point? You have choices. Each step
along the way, I was offered many choic-
es—all free—to get the job done. The
choices of PostgreSQL over MySQL and
Ruby with Rails over Python with Django
were not hard and possibly not impor-
tant. That is, for no cost, we can down-
load all the options and test them out.
The evaluation process was not encum-
bered by license fees and paperwork.

It also means what we saw as the best
tool set for the job can be selected with-
out needing to look at financial or politi-
cal issues. In addition, because everything
we selected is open source and well doc-
umented, we are not locked in. If, for
example, we find that PostgreSQL was
the wrong choice for our database, it
would take very little work to replace it
with another database, such as MySQL.

So, next time people suggest that select-
ing Linux and/or open-source software is
painting yourself into a corner, suggest they
think again. Choosing an open option today
is the best way to ensure you will have
choices in the future.�

Phil Hughes is Group Publisher for SSC Media Corp.
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At last month’s 4th Annual Desktop Linux
summit, Linspire announced an open-
source, no-cost version of its operating
system entitled Freespire. Kevin Carmony,
Linspire’s President and CEO, unveiled the
Freespire Project in his keynote address,
claiming that Freespire will eliminate the
resistance some potential users have with
using Linux on their desktop or laptop
computers. Carmony hopes that offering
proprietary drivers and software as a
choice will create more desktop Linux
users, because of the out-of-the-box legal
support for MP3, DVD, Windows Media,
QuickTime, Java, Flash, Real, ATI drivers,
NVIDIA drivers, Adobe Acrobat Reader,
third-party fonts and so on. Even though
Linspire has made this new product
announcement, it has no plans to elimi-
nate its commercial Linspire offering.
Indeed, like many other companies that
support both open-source and commer-
cial versions of software (for example,

Fedora and Red Hat and OpenSUSE and
Novell), Freespire will become the proving
grounds for new enhancements, helping
to improve the commercial version of
the Linsipre OS.

Carmony explained in his address how
Freespire is a community-driven and
developed project, which has been under
development for approximately two
years. Still, the first beta version down-
load won’t be available until around
August 2006. Freespire will be unique for
open-source Linux distributions in that it
will give users the choice to download a
version that is 100% open source or one
that includes proprietary software. As a
free, community-driven distribution,
Freespire should appeal to users, but it
also will appeal to developers by includ-
ing common software development tools
by default. Although developers will be
among the target users, Freespire will not
target the server market; it will be opti-

mized for desktop and laptop computers.
Hopefully, a good part of the two years

spent on Freespire thus far will have been
on managing the Linspire/Freespire archi-
tecture. If they remain as one code base,
this will simplify life for Linspire engineers;
however, if with the addition of Freespire
there are now two code bases, migrating
functionality from one to the other might
be difficult. It will be interesting to put the
two distributions side by side when
Freespire becomes available.

As part of this new project, Linspire
also will release its Click and Run (CNR)
software with an open-source license
and include it in the Freespire Project.
The CNR utility provides one-click graphical
installation and de-installation of soft-
ware from Linspire’s CNR warehouse.
According to information provided by the
company, the CNR client has better than
a 98% installation success rate, attributing
most failures to modem drop-offs.
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By combining a new community-driven Linux distribution with proprietary technology, Linspire will drive Linux adoption to new levels.

KEVIN SHOCKEY
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With the release of CNR as open source,
it is clear that Linspire hopes, through adop-
tion of Freespire and the adoption by other
distributions of the Click and Run client, it
will be able to drive up subscriptions ($20
US for the basic CNR subscription) and soft-
ware sales from its CNR warehouse (the
CNR warehouse includes commercial pro-
grams, such as StarOffice, CrossOver Office,
Cedega and many others). Clearly, with
Freespire, I think the company will be
successful; however, its dream of wide-
spread adoption of CNR is a stretch. The
community must perceive the CNR client to
be of such great value that those projects
will assume the task of modifying the client
to work with non-Debian distributions.
Because Linspire is a Debian derivative, it is
reasonable to believe that Debian and all
other derivatives could use the client with
relatively little effort. Beyond Debian, I can’t
see Novell departing from YaST for SUSE or
Red Hat/Fedora departing from Yum.

Perhaps the biggest question this
announcement raises is, why now? Why
after five years is Linspire finally releasing
an open-source version of its operating
system? According to the company, the
answer revolves around laying the ground-
work with OEM and retail channels and
making sure that Linspire had a sound and
viable business model first. So, when it
started Freespire, Linspire was satisfied
with the success of its model, and felt
comfortable it would be around for a long

time. The second reason Linspire felt it
was the right time is that before, the
Open Source world probably wasn’t ready
to be open minded to the notion of
including some proprietary software in a
community distribution of Linux. Linspire’s
vision is that the community will see the
value in such an approach as a way to fur-
ther the adoption of Linux and open-
source software.

In fact, Linspire believes the larger
community will recognize that Freespire
won’t hurt the momentum of open source
by offering the option of proprietary
codecs, drivers and applications. It sees
Freespire as an opportunity to influence
the future of computing to become more
open, by expanding Linux adoption and
thus expanding its circle of influence by
gaining a much larger user base. Linspire
believes that a big portion of the world is
turned off by Linux, because it doesn’t
legally support things like MP3, DVD, Java,
Flash, Windows Media, QuickTime and so
on, out of the box. The core premise
Freespire was founded on is that asking
millions of people to throw away their
iPods (or other favorite MP3 player), or
not legally watch DVDs on their computers,
is just too much to ask. Linspire believes
that the Freespire Project provides a free
marketplace where the user can decide
what software to install and use.

I agree with Linspire that many Windows
users are looking for an easy “it just works”

alternative, and although media support is
an important obstacle to breach, it is not
the only or the largest hurdle. I wish Linspire
would also announce soon the availability
of Photoshop, AutoCAD, Quicken and
Quickbooks within its CNR warehouse. For
without these applications (and many more)
and greatly increased support for propri-
etary hardware drivers, we’ll still be missing
the lion’s share of the desktop market.

In at least providing a new alternative
to grow the volume of Linux users, I com-
mend Linspire on its new Freespire Project.
With it, we’ll hopefully be able to demon-
strate objectively to companies like Adobe,
Quicken and AutoDesk that there will be
sufficient volume within Linux. Then,
hopefully, these companies will decide to
release a Linux version and fan the fires of
widespread Linux desktop adoption.�

Kevin Shockey is Editor in Chief of TUX.
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EDITOR’S NOTE
Following the announcement of
Freespire and writing this article,
I applied for and was accepted 
onto the leadership board of the
Freespire Project. It is an honor to
join the board, and I look forward
to reporting on the progress of the
project as it matures.

http://www.tuxmagazine.com
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Praise for “Linux’s 
Fundamental Difference”
I’m not much for writing letters, but after
reading Kevin Shockey’s “Linux’s
Fundamental Difference” in the May
2006 issue, I could not help myself. He hit
the nail right on the head with his
answer—control. The reason I joined the
Linux camp was to get back the control I
had when I first got into computers.

This brings back memories of why I like
computers and really took an interest in
them. My first computer was a Atari
XL800, which I spent many hours on writ-
ing programs. And the reason I like to pro-
gram was that I found I could save money,
because I could write my own programs
instead of spending money to buy them. I
had control. Then came MS-DOS, and then
MS Windows, which started to change my
way of thinking. I found myself buying
software, because it was cheap back then
and quicker than writing my own code.
(But this has changed—the quickness is
there, but the cost is out of reach.)

Well, now that I joined Linux camp, I find
that if I want to, I can get top-notch soft-
ware, because others have made the code
available for others to improve on (open
source). In short, I really have the control

back that I had when I first got into com-
puting. Kevin, thanks for the great article.
--
Irv Risch

I’m really glad my editorial hit the mark.
When I discovered the answer, it was a bit
of a revelation for me as well, so I knew I
had to share it with everyone.—Ed.

Accentuate the Positive
I enjoy reading your editorials over all of
the other articles in TUX. I support
Windows Server and my company’s prod-
ucts that run on Windows Server.
Recently, after seven years of not adopt-
ing Linux, I have embraced Linux. My
company plans to offer products on
Linux, and I see the writing on the wall. I
see many positives, as your May 2006
editorial points out. The thing that upsets
me most, and this does not include you,
is the Windows-bashing in TUX and other
communications that I purchase. Being
open, honest and to the point does not
have to include bashing. Bashing is a
turn-off to folks like me that intend to
use Linux and Windows. I recently vowed
never to return to a local Linux Users
Group (NTLUG) that spent at least half of
the meeting bashing Microsoft rather
than teaching me an alternative for my

benefit. Linux can stand on its own.
Thank you and I’ll keep reading TUX.
--
Ron Hudson

I’ve spoken to many people on this point.
We are a divisive and tribal species that
reap perverse pleasure in alienating
people. I learned a powerful lesson from
one of the worst bosses I ever had. He
thought that because he was intelligent,
which he was, that meant everyone else
was stupid, which they were not. My
point is that one of our fundamental
motivations is to be right, and sometimes
we can feel right only by making some-
one wrong. Any company, any software
or any product neatly fills in that equa-
tion, and voilà, through reverse deduction,
we can claim someone is wrong, so we
must be right. And, being right makes us
feel better about ourselves. The tragedy is
that we all do it to one extent or another.
What you are calling for is my wish for
the Open Source community.—Ed.

Looking for My Killer App
I’ve used a few distros at home over the
years, but they’ve never lasted in the long
run, and I’ve reverted to XP for my killer
apps: games and kids’ home video edit-
ing/creation/burning to DivX/DVD for

LETTERS
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playback on the big TV.

Checking out your back issues soon had
me installing Kubuntu 5.10 onto my
AMD64 PC to see the current state of
desktop Linux. I’m a GNOME guy who
grew up from Red Hat 5.2, SUSE and
more recently, Ubuntu/Kubuntu, and I’ve
even gone so far as to check out the
“dark side” that is KDE. Good stuff—I’m
having fun using KDE, and your great
mag is providing a good starting point in
that regard—thanks.

So, on to my killer apps. I can live with
an XP partition for my occasional gaming
addiction, but I’d like to know what my
options are with regard to out-of-the-box
video editing, similar to out-of-the-box
Windows Movie Maker and the like. I’d
like to take advantage of my 64-bit CPU
rendering power and would rather 
follow the Linux path instead of Vista
when that ships.

It looks like Diva and Kino are the two
video-editing apps out there for Linux.
Are there any others I’m missing or that
may be coming down the pipe sometime
soon? I’d rather just apt-get install
them instead of jumping through fiery
hoops in a yappy dog suit just to install
them via their myriad of scripts. Any
thoughts and future articles in this area?
--
iain charlton

Request for More 
Coverage of BSD
Just wanted to say kudos on a great mag-
azine! I’ve been looking for a magazine
like this that covers a lot of software avail-
able for Linux as well as different distribu-
tions and practical how-tos. I downloaded
all your issues, and I have read about four
magazines so far. I love your coverage on
OpenOffice.org! I’ve been using
OpenOffice.org for more than a year now,
but there is still so much to learn. Your
articles have been very informative. I
would like to see a little more coverage on
the BSDs, which are also free, although a
lot of the software you cover still applies
to BSD (such as KDE). Maybe an article on
the up-and-coming DesktopBSD and
PCBSD aimed at making FreeBSD easier to
use (both use KDE) just to make the read-
ers aware of alternatives?

I have been playing around with Linux
since the mid 1990s off and on, but I’m
not an expert (except for installing it). I’ve
gone from Slackware, Red Hat 6.0,
Mandrake 8.0 (fell in love with its user-
friendliness) all the way to Mandriva
2006.0. I’m currently interested in trying
Kubuntu and seeing how easy it is to use. I
really believe that I’m at a point where I
can migrate most of my machines over to
Linux/BSD and be happy without Windows
except for certain development projects.
--
J. Atkinson

Thanks for the Smackdown
I discovered TUX in its second issue and
have never missed an issue since. By far,
your greatest single piece to date is the
Distribution Smackdown. I am not entirely
new to Linux. I have used a variety of dis-
tributions during the past four years, but I
still felt the desire to keep exploring to
learn more about the different distribu-
tions available. Comparing seven in one
place really helped me there. I had used
Mandriva, Fedora and SUSE. I also had
played with Ubuntu/Kubuntu, and partly
because of what I had read in TUX, I had
tried Linspire. Thanks to the Smackdown,
I decided to give MEPIS a try to see how
it really did on some of the less Linux-
friendly media I had, like the QuickTime
movies from my digital camera.

Download, burn, install, play—as advertised,
it worked better on every type of media I
tried than anything before had done. I still
plan to keep tabs on various distributions
and take advantage of the improvements
born of competition between them, but I
am switching my main OS to MEPIS.

Sadly, the Smackdown was not fully satis-
fying. I was disappointed when I got to the
“review” of the Editors’ Choice. It seems
that the party shouts of “Go Mandriva!”
interfered with actually writing a review
where the various areas were broken
down. For example, Mandriva scored a five
on multimedia, but even on reviewing the
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article, I can’t find more than a passing ref-
erence on the order of “Mandriva plays
media” to explain how it got that score.

Once again, thanks for the Smackdown. It
should be a regular feature—perhaps annu-
al. Next time, try to make sure that the party
for the winner doesn’t drown out an actual
review of the highest-rated distribution.
--
David

Impatience Slows 
Linux Adoption
In the April 2006 issue of TUX, the impa-
tience displayed by some hobbyists toward
“the current influx of Linux users” demon-
strates at least one reason why Linux is
not more popular than it is and should be.

New Linux users don’t want Linux to be like
Windows; they want Linux to be as easy to
use as Windows. They don’t want the DRM
and spyware-ridden Windows bloatware
any more than longtime Linux fans do.
And, they’re just as supportive of the con-
cept of open-source software as those
ready to compile their own installations.

Many of them, however, are not hobby-
ists. They truly don’t have time to con-
struct Linux kits. They have real jobs to
do with their new Linux software. They
need to write letters, print labels, send
out bills, scan photographs and publish
newsletters. The hours they have to
spend figuring out how to install or use

their software come straight out of their
income or profit margin.

And, Linux distributions continue to get
better, become easier to install, and more
functional, because more and more new
Linux users persevere despite the snob-
bish attitudes of some hobbyists who
would like us all to go away.
--
Robert Smits

Kudos for the Letters Section
Great magazine. Not only are the articles
useful and interesting, but even some of
the letters contain very helpful tips for
new Linux users. I found the letter on
Adding Multimedia to SUSE 10.0 by Petar
Sarajcev [May 2006 issue] extremely use-
ful. Offer him a regular column!
--
Dr Stephen Hinton

Praise and Article Suggestions
First of all, I would like to thank you
immensely for filling a need with your
magazine. I am an in-house Digital Media
Designer in the Washington DC Metro
Area (remember when we were just
called Graphic Designers?) and I am
hooked on Linux, although at work I have
a PC and a Mac on my desk. I have been
unsuccessful at getting our IT department
to allow me to partition the PC so I can
install Linux on it. In addition to express-
ing my gratitude for your efforts, I would
like to know if any of the following topics

are forthcoming in your magazine, as I
will be waiting with baited breath.

Scribus: a more in-depth look, particularly
with its publishing and interactive PDF
tools. Right now, I think Scribus is the
closest alternative to running a full-blown
version of Acrobat in Linux for creating
interactive PDF documents. I would love to
see you guys do a mini-series on it in the
same way that you did one on Inkscape.

Blender: I have been studying this one
for a little more than a year. One of the
most powerful open-source tools out
there, I would love to see a series on
this one. As the only designer where I
work, I use 3-D tools to create digital
imagery for my layouts and multimedia
presentations. I find Blender to be a very
useful addition to my arsenal.

Kino and Cinelerra: these are the one-two
punch for video in Linux. Again, I would
love to read any articles you would pub-
lish on these.

Jahshaka: ironically enough, I have not
been able to get the newer versions of
Jahshaka to run on my Fedora Core
(GNOME) or Mandriva (KDE) distribu-
tions. It seems to run like a clock on my
XP computer at work; however, I attrib-
ute this to the fact that my XP box at
work is a P4/3GHz, while my home box
is a PIII/1.1GHz (the on-line documenta-
tion even states that it was being devel-
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oped on 2GHz boxes). I will be choosing
a 3GHz box in the near future and
installing Mandriva on it, so I will let you
know. The main reason that I mention
Jahshaka is that I find it to be one of the
few contenders to being a true open-
source motion graphics editor with any
teeth out there.

Fink (for Mac OS X): I am not a program-
mer, but I would like to run several of the
above tools through OS X, and their
respective sites state that this is possible
through Fink. I know for a fact that it is
possible to run Inkscape, Scribus and
GIMP through Fink.

I have no idea if there is a community of
designers out there who would be inter-
ested in reading articles on the aforemen-
tioned software packages; if not, thank
you for listening. I have to get back to
downloading the rest of your back issues.
Oh, and tell Mango that, as cartoons and
comics were the things that initially got
me into art, I’m a huge fan of Ghost in
the Shell, Vampire Hunter D and anything
Shirow. Thank you for your time.
--
graphixgeek

We'll be delving more into Scribus, and
introducing Blender sounds like a great
idea. We’ll be getting into video editing
in our Linux Media Center issue coming 
in August 2006.—Ed.

Control Extends 
to Privacy as Well
Many thanks for your magazine. It is a
wonderful help and resource for all of
the computer users who are and have
been moving to Linux. I was reading Mr
Shockey’s article in the May 2006 issue
and his answer of control. I wanted to
mention that control also comes in when
Microsoft and other proprietary software
allow themselves to look into your com-
puter to see where you browse, where
you send e-mail and purchase things.
This is a privacy issue that certainly
comes under your heading of control.
With the music and video market trying
to keep users from sharing products they
want to see, they invade your privacy
and control what you can and can’t do
with your computer. For example, if you
don’t have the proper software—say,
Windows and some other proprietary
software—you won’t be able to play cer-
tain DVD movies or music CDs.

They may even check your hardware and
mac addresses, and so forth, without your
permission or knowledge. Privacy is a big
issue. I believe that your big-time CEO
might be interested and it comes in under
what you say of control.

Thanks again for the great magazine and
community of cooperation and collabora-
tion, freedom and right for the individual
as well as the group. These are very basic
things that make us more cultured and

civilised and can lead us to our higher
selves and higher than the godhead of
commercialism. It can help the world live
together in harmony and diversity, peace
and opportunity and the openness and
respect to grow into our true highest
selves, which can respect the planet and
its resources as well as the groups and
individuals that live on it.
--
Markandeya

The Need for One Distro 
to Rule Them All?
I am now retired but have used, built
and supported PC hardware and soft-
ware since the 8086 and DOS. I have
been dabbling with Linux distros for a
few years but still regard myself as a
newbie. Referring to the article “Linux’s
Fundamental Difference” in the May
2006 edition of TUX, I find that the
biggest difference is that there is only
one Microsoft Windows (that is, the cur-
rent XP version let’s say), but there are
umpteen Linux distros. Yes, there is
strength in diversity, but there is also
confusion. Your excellent magazine helps
to focus the attention of a newbie onto
the top ten distros at any one time, but
even the top ten change from year to
year. For me, the most annoying feature
of Linux is that it is split four ways
between GNOME, KDE, Debian-based
and RPM-based, all of which have pros
and cons. Fewer choices would be better
long term, as this is currently a repeat of
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VHS or Betamax, -R or +R and so on.
What we need is a +_R now please.

Picking a winner out of all these and
deciding where best to invest your time
as a newbie is a nightmare. If I had to,
I could live with one of your current
top ten if Microsoft folded up tomor-
row. And if that happened, I might
eventually find more than a handful of
friends who used Linux from whom I
could seek advice, assuming that they
picked the same one as me. So my
somewhat controversial opinion on
Linux is that it is a hopeless case—or,
rather, umpteen hopeless cases at the
moment. Having said that, I can appre-
ciate that the writing is on the wall and
one day, possibly in my lifetime, it
could make it into the big time. My
definition of making it into the big
time is when my 15 year old daughter
knows as much about Linux as she
does about Windows. Okay, it’s not
going to be my daughter but maybe it
will be her daughter or granddaughter?
I am at least happy that my daughter
knows of the existence of Linux as
something strange that Dad uses on his
PC, but that is where it stops. So the
difference between Windows and
Linux? Windows is a proprietary tech-
nology that has been focused into suc-
cessive single products that have world-
wide success, and Linux is public
domain, unfocused and has umpteen
products with no real worldwide suc-

cess. Linux has at best isolated regional
successes—Fedora in the US, SUSE in
Europe and Ubuntu in Africa.

My letter may not be well received in your
mag, but if it helps to focus the Linux
cause in any way I will be pleased.
--
Bob Owen

Thanks for the great letter. This brings
into focus the most critical issues for
new Linux users. After choosing to
adopt Linux, they are faced with count-
less decisions and alternatives. However,
refuting these choices in some ways
refutes everything that makes Linux and
open source special. I would go so far
as to say that I believe that Linux and
open-source’s ability to meet even the
smallest of needs, fundamentally makes
it much more desirable than anything
previously available. The opposite
approach is to build one piece of soft-
ware and try to make it do everything
for everybody. With this approach, most
users end up using a small percentage
of the software they acquire.

If you are looking for some blanket
advice, any newcomer to Linux that finds
the alternatives too perplexing should
turn to the commercial distributions that
are aiming to make the end-user experi-
ence as simple as possible. The two dis-
tribution options I would recommend are
Linspire and Mandriva.—Ed.

Slackware Review Please
This is my third mail; however, none of
my previous mails have been published.
Still I have not lost hope. I hope that at
least this one will be published.

I am disappointed to find that Slackware
was not included in the distribution smack-
down of the April 2006 Issue. I accept that
Slackware is not as simple as many of the
modern distros, but it is definitely not a
difficult thing to handle. It would get a
good score in many of the sections consid-
ered in the smackdown. It has excellent
support for multimedia too. Several com-
mon formats like MP3 and DVDs can be
played out of the box. It is also completely
free of cost, and it is rock stable by nature.
Even though it was not included in the
smackdown, it would be great if you could
do a review of it as a separate article.
--
Chandru

Although Slackware isn’t known for its
popularity with new Linux users (which is
why we didn’t review it in the Smackdown
issue), we’ll review it next month.—Ed.

A Scared Reader Sounds Off 
on the Digital Millennium
Copyright Act
As I explore Linux more and more, I’m
running into discussions about the Digital
Millennium Copyright Act. And, it’s scary.

Let’s back up a bit. I run Windows XP, and
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I run Linspire 5.0.

Linspire has shown me that there is an alter-
native to Windows. So far, so good. Now
I’m looking at Ubuntu. So, I installed it. But,
it doesn’t play my DVDs or film clips and so
on. Looking around the Web, I found infor-
mation on Automatix. But, it appears, if you
live in the US, installing Automatix is a crime.

TUX needs to do an in-depth story on
DMCA, the Linux distros that allow users
to play DVD/music content legally and the
programs and apps out there that may
place us in legal jeopardy.

No one, on any of the forums I’ve visited,
can give me a definitive answer. Frankly,
I’m erasing my HD of Ubuntu until I get an
explanation from someone in the know.
You folks at TUX just may be the ones to
provide it for me and many others. I look
forward to hearing from you soon.
--
Mark

Thanks for sharing your concern and shed-
ding a little light on this confusing issue. I
agree with you; I’ll address this personally in
our August Linux Media Center Issue.—Ed.

Looking for Linux Printing
Help? Try TurboPrint
David A. Tigue writes that one has to be
careful about buying printers that are also
Linux-friendly [May 2006 Letters]. I can
say “amen” to that as I found out after

purchasing a Canon printer that they are
the equivalent of Windoze modems—that
is, they work only with Windoze.
However, there is a fairly cheap and
straightforward way out: there is a pack-
age called TurboPrint that allows strange
printers such as Canon to be used under
Linux. I can recommend it as my expen-
sive Canon i860 is now usable.
--
Croombe F. Pensom

Another Point of Control
Gained by Using Linux: 
Control over Your Data
Regarding “Linux’s Fundamental
Difference” in the May 2006 issue, I
agree with you that the biggest difference
between Windows and Linux is the con-
trol. But not necessarily control over costs
and so forth, but control over your data.
Who owns your data? That is the
response I would use. This is one of the
main reasons that I can tell as to why the
Council of Massachusetts is wanting to
get all documents in ODF as standard.

I also came across this at home. I wanted
to sort my photos, tag them and so on—
20,000 of them. So on my Linux desktop
I used digiKam. It has a nice interface and
just worked.

Now, my wife wanted to do some of the
sorting on her Windows notebook. But
digiKam is not available for that. So she had
a look around and found Adobe Photo

Album, which has almost all the features she
wanted. But once she started to sort things
out, we found that we couldn’t get the data
that we had entered out of it. Now Adobe
owned my data, my tags and descriptions,
even if not the photos themselves.

Now, with digiKam, it stores the data in
an SQLite database, which I can read with
standard tools that have nothing at all to
do with digiKam.

Sure, I might have trouble decoding the
tables (which I didn’t, by the way), but
then the code on how it all ties together
is in the digiKam source anyway. So in
this case, I own the data.

Now you could say that the program has
a way to export the data out to some-
thing that can be read (such as XML, text,
HTML and so on), and then I have my
data. But if that is not the default (some-
thing easy to read), then when it comes
time to migrate, or use that data, does
the original program still exist, work or
have something that will run it?

So, to sum it all up, I would answer that
the biggest difference between a propri-
etary and open-source solution is control
of the data and ownership of the data.

Thank you for the wonderful mag that I
get to read, and for the time to read this.
--
Fran Firman�
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I love spring. Spring is when the pretty flowers bloom. I take pictures
of pretty flowers. I paint pretty flowers. Flowers are not as pretty as I
am, but they are pretty enough for pictures and paintings.

My boyfriend Otaku thinks I am too old fashioned. I use a
35mm Nikon N90S camera to take my pictures. It uses real film
not digital film. I like real film. I like the Kodachrome colors. I
like the depth-of-field preview feature on my Nikon camera. It
shows me what will be in focus and what will not be in focus.
This way I can change the camera settings to take a sharp pic-
ture of a flower and keep the leaves in the background blurred.
Some digital cameras can do this too, but I still like my Nikon.

Why? I print my own photographs too. I use Ilfochrome
Classic. Somebody told me it used to be called Cibachrome. I do
not know why they changed the name. I only know I like the
way Ilfochrome prints look. They do not look like the real flow-
ers. They are brighter, and there is bleeding and high contrast.
Some people think this is bad, but I think it makes the flower
pictures look so pretty. I do not know any way to get pictures
from an ink jet printer that look as good as my Ilfochrome pic-
tures, so I do not care if I am old fashioned. I am too young to
be old fashioned anyway. I am just fashioned.

I like the way you fashion your questions with passion. But
you do not send me as many questions now. What happened?
Are you afraid of me? How can you be afraid of a cute, humble,
delicate princess such as me? I will not bite you, I promise.
Please send me more questions.

Q In your column in the May 2006 issue, you advised Nils, who
had a clock problem with an ECS computer to try several

software solutions. If the ECS computer uses a 64-bit microproces-
sor, the more likely problem is that the clock is running double
speed under MEPIS. My Compaq Presario 2175US uses an AMD
Turion chip, and I had the exact same problem. The solution,
rather simple, is to add noapic to the boot line in GRUB.—Mark

A I thought of the same answer, but I did not want to 
say it.

Okay, I did not think of the same answer. You have good
information, and I think that this is the problem Nils has with his
computer. Why? Because he says his clock runs two times as
fast as it should run. I never have a problem with my computer
clocks running twice as fast as they are supposed to run. They
run way too fast, but not twice as fast.

Thank you very much for this information. I hope Nils reads
this issue, just in case this is the problem with his computer, and
this is why his clock is running too fast.

Q I am using NVIDIA TNT2 Pro and am wondering if I should
install the NVIDIA Linux drivers (for OpenSUSE 10). Any

idea what the effect will be? Will it enhance the graphics, or is it
good only for 3-D? I added Guru’s FTP as my installation source
and a few others, but I am still unable to use YaST to find the
NVIDIA driver to install. What should I do in order to install the

Mango gets a better answer to fast clocks, gives advice to an NVIDIA TNT2 user, provides tips to a user of
buggy Fedora Core 3 and shows you how to integrate on-screen-display messages into your applications.
MANGO PARFAIT
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NVIDIA driver using YaST? I went to the NVIDIA Web site to
download the driver and noticed that I had two options: to
download the newest driver or download the driver for TNT2
specifically, which is dated 2002.

Which driver should I use?—Michal

A The NVIDIA proprietary driver is most tuned for 3-D per-
formance. The NVIDIA TNT2 Pro is an old graphics card,

so it does not do 3-D as well as a new card. The proprietary
driver will not improve your display enough to be worth your
trouble. So do not worry about using the special driver. Use
the normal driver.

You can buy a cheap new NVIDIA graphics card that is so
much better than the TNT2 Pro that you will not believe the dif-
ference. Here is your problem. If you are using a TNT2 Pro, I
think you are using an old computer with an old, slow AGP slot.
If you buy a new NVIDIA card, it will not work very well in this
system. So, you still will not get much better graphics with the
new card and the NVIDIA proprietary driver.

I think you must upgrade more stuff if you want to use fancy
3-D on your computer. Here is how I think you should upgrade.
Look behind the computer. Do you see where the power cord is
attached to the power supply? Unplug this power cord. Do not
throw away the power cord. You will need it later. Now give
away your old computer and buy a new one. Put the new com-
puter where the old one was. Now plug the power cord from
the old computer into the power supply of the new computer.
You are done.

Maybe your new computer comes with its own power cord.
That is okay. Now you have a new computer and an extra
power cord. When you get the new computer working, let me
know and I will tell you how to install the NVIDIA driver.

Q I have tried so many different places to solve this prob-
lem—Google, forums, other magazines—and no one has

been able to solve it for me! You are my last hope to solve what
is a very annoying problem! While I’m working away in Linux—
this problem has occurred for me in both Ubuntu and Fedora—
the window I’m in just disappears! It has happened when I’m
listening to audio in the window and the audio has kept playing
but the window is gone. More recently, however, the processes
are seeming to disappear from the system monitor as well.

I can’t believe this is a problem for all Linux users, because it’s
so annoying, nobody would ever use it! I have been using Fedora
for nearly six months now, and I am very happy with everything,
besides the disappearing windows...please help!—Jon

A I think you are running Fedora Core 3 and GNOME, right?
I think to myself, GNOME uses Metacity for a window

manager for a long time, right? Fedora Core 3 must be using
Metacity, right? But I do not think I am right, because many
people who use Fedora Core 3 complain about disappearing
windows. The answer is always that there is a bug in the sawfish
window manager. The sawfish window manager used to be
called sawmill. It is important for you to know this, because
someday you may play a trivia game and someone will ask you,
“What was sawfish called before it was called sawfish?” Now
you can win a point because you know the answer is sawmill.

Maybe you can get a fixed version of sawfish for Fedora Core 3.
I do not think so, because I know many people who complain
about this problem and they do not know where to get the fix.

I do know three ways you can avoid this bug.
Here is one way to work around the bug. You can add a win-

dow list to the panel. Do not think I am talking about a taskbar.
I am not talking about a taskbar. I mean a drop-down window
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list. I think the windows will show up in this list even when they
disappear. Select the window that disappeared from this list,
and it should reappear like magic.

You also can change window managers. Stop using sawfish
and switch to a window manager that works. If you are
using GNOME, there are many other window managers 
that will work. Metacity works, and it is the default window
manager for GNOME. IceWM works too, and there is a 
version made for GNOME.

I want to tell you the menu choices to add a window list or
change window managers, but Fedora Core 3 is too old for me.
I do not use it. I do not want to guess about the commands, so
I hope you will find the right menu choices on your own.

But I think these are bad answers. Here is my best answer.
Fedora Core 5 is ready now. Why do you not upgrade from
Fedora Core 3 to Fedora Core 5? You can upgrade to Fedora
Core 4 if this is too much change. This will fix the disappearing
window problem and give you the better software that is
available in the latest versions.

FUN WITH OSD
I have a fun trick to tell you. I think maybe you have a television
that shows a green volume number or slider when you change
the volume, right? This is called on-screen-display. Maybe you
even have an on-screen-display for things like the volume on
your computer. Did you know you can make your own on-
screen-display messages?

Here is how. First, you need to install the on-screen-display
package. The package is called xosd-bin for my distribution.
Maybe it is called xosd for your distribution. You look for it. I am
sure you will find it okay. Install this package with your favorite

package manager.
This installs a program called osd_cat. Make sure you have

osd_cat installed. Open a terminal or simply press Alt-F2 in KDE,
and type the command osd_cat, then press the Enter key. If
KDE complains (or you see an error at a command line in the
terminal), you do not have the right xosd package installed.

Now, let’s try to use osd_cat. The command is not very
friendly. So I will not bore you with all of the details on why the
command I am giving you looks the way it does. Trust me. This
should work for you. Press Alt-F2 in KDE to type in a command,
and then type this:

echo "Hello" | osd_cat -p middle -A 
�center -f -*-lucida-*-*-*-*-*-240

Do this with careful typing. The hard part is the font which is
-*-lucida-*-*-*-*-*-240. There are five stars with dashes before
you get to the number 240. The other hard part is the vertical
line after “Hello”. This is a vertical bar that is above the back-
slash (\) on your keyboard. This command should be all one line
when you type it (there isn’t enough space to make it all one
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Figure 1. Run osd_cat in the KDE command window.

STOP USING SAWFISH AND SWITCH TO A WINDOW MANAGER THAT WORKS.
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line here, so we add a continuation arrow).
If you pressed Alt-F2 in KDE you should see something like

what you see in Figure 1.
Did you type it okay? Press Enter. You should see a big red

“Hello” in the middle of the screen. Clap for yourself! You put
an on-screen-display message on your screen. If you do not see
“Hello” in the middle of the screen, maybe you typed some-
thing incorrectly. Maybe you do not have the lucida font
installed. You should have the lucida font installed. It is a very
popular font.

I know you are thinking, “What is the point? Why do I
want to say hello to myself?” You are very impatient. Maybe
you need to stop drinking so much green tea or switch to
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Figure 2. Mail Settings for Kontact

Figure 3. Setting How Kontact Will Notify You When Mail Arrives
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decaf coffee. I am getting to the good part. Be patient. It
will not take long. I am not the kind of person who rambles
on and on and wastes your time before I get to the good
part. I get to it right away. You wait and see. I do not dilly
dally. I do not even dilly. I go right past dilly and dally and
tell you the good parts.

By the way, did I tell you about my friend Bunny and her
obsession with Armadillos? I am teasing you. I will get to the
good part now.

You can tell some applications to run a program to alert you
when something important happens. Kontact has this feature.
Kontact is the KDE personal information manager. It contains
Kmail, a mail program. Open up Kontact. From the main menu,
click Settings→Configure Kontact. Click on Accounts in the
list on the left. You should see something like what you see
in Figure 2.

Click on the Other Actions button. You should see a window
like the one shown in Figure 3.

You can tell Kontact to play a sound when mail arrives. This
is good. But maybe other programs use the same sound for dif-
ferent reasons. So how do you know that the sound means you
have new mail? We are going to fix that. You must press the
Advanced >> button first. Then you will see a screen like the
one shown in Figure 4.

Do you see that you can execute a program in addition to
play a sound? This is what you want to do. Click the box that
says execute a program. Then, use the edit field to type in a
command like the one we have above with a little change:

echo "Mango has new mail!" | osd_cat -p middle 
�-A center -f -*-lucida-*-*-*-*-*-240

Do not use the name Mango unless your name is Mango. If
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your name is Mango, I am pleased to meet
you. I am so happy to meet someone else
named Mango. Maybe we are related? If
your name is not Mango, I feel sorry for you,
but you still need to put your name in the
place of Mango in this command.

Click the Apply button and then the
Okay button. Close the settings windows
until you get back to the Kontact program.

If you typed everything okay, you
should hear the incoming mail sound
and see a message on your screen
whenever new mail arrives. See Figure 5
for an example. The example shows the
message on a blank screen. If you are
using an application like a word processor,
the message will still show up on top of
your word processor.

The program osd_cat will display the mes-
sage for five seconds. If you want to change
the time it waits before it takes away the
message, add -d <time in seconds> to the
command. If you want the message to stay
on the screen for ten seconds, the new 
command would be:

echo "Mango has new mail!" | osd_cat -d 10 -p 
�middle -A center -f -*-lucida-*-*-*-*-*-240

Not every application will let you run a command when some-
thing important happens. But some programs do. J-Pilot is anoth-
er personal information program that lets you run a command for
an alarm, like when J-Pilot must tell you that you have an
appointment. Play with the applications you use and see if they

let you run commands for alerts. It is nice to have an on-screen
message for an alarm because it is harder to ignore than a sound.

Have fun! Keep sending me your questions!�

I am a sweet, humble, delicate and very cute genius who is at your service to
answer your Linux questions. Send your questions to mango@tuxmagazine.com. 
I am deeply sorry that I do not have time to respond to anyone directly by e-mail,
but I will select as many questions as I can and answer them here.
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Figure 5. Mango has a new mail alert.
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Plenty of textbooks and teaching materials can help you learn foreign languages
one way or another. Yet, there is no way to learn a foreign language without
memorizing vocabulary and looking up words in a dictionary. This is difficult and
often not very exciting work, but a few tools can make the process of acquiring
new words and expressions a bit more tolerable and effective.

JVLT
jVLT (http://jvlt.sourceforge.net) is described as, “a flash-card-based vocabulary
learning tool”, but there is much more to it than that. Besides the flash-card
part called Quiz, the application also contains rather useful Vocabulary and
Examples modules that allow you to store not only words and their translations,
but also other useful context information. jVLT is a Java-based application, so
before you can run it, make sure you have the Java Runtime Environment (JRE)
installed on your machine. If your distribution doesn’t include JRE, you can
download it free of charge from http://www.java.com. jVLT is available as a .jar
file that requires no installation. Simply download the latest version from
http://prdownloads.sourceforge.net/jvlt/jvlt-0.8.1.jar?download and run
it by double-clicking on the jvlt-x.x.x.jar file. If double-clicking doesn’t
work, launch the terminal, switch to the application’s directory and run
the java -jar jvlt-x.x.x.jar command.

Once jVLT is up and running, you must populate it with vocabulary data.
Click on the Create new file icon, and press the Add button. This opens the
Add entry dialog window, where you enter a word, its pronunciation and
senses (translations and their definitions). The ability to manage multiple
senses sets jVLT apart from other similar applications and allows you to
capture all possible meanings of the word. Moreover, if you press the

Advanced button, you can add more information about the word, such as
categories and multimedia files. Under the Categories tab, you can assign
multiple categories to the word, which comes in handy when you want,
for example, to browse the words from a particular lesson or topic. In the
Multimedia files section, you can add a sound file and a picture. Once
you’ve added all the word’s data, press the OK button. In this way, you
can add as many words as you like.

As you keep adding new entries to jVLT, locating certain words simply by

LLeeaarrnniinngg  FFoorreeiiggnn  LLaanngguuaaggeess  wwiitthh  jjVVLLTT  aanndd  SSttaarrDDiicctt
For many new users, the breadth of free applications available becomes
one of the most appealing features of Linux. Dmitri Popov introduces two
such applications available to help learn a foreign language.

DMITRI POPOV
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Figure 1. jVLT includes three modules to help you learn new words.
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scrolling through the list
becomes more difficult.
Fortunately, jVLT
includes a filtering fea-
ture that makes it easier
to view the words that
match the defined crite-
ria. If you tick the
Advanced filter check
box, you can define a
filter based on one or
multiple criteria. For
example, you can
define a filter that finds
all the words belonging
to a particular category
(assuming you’ve
assigned categories),
having a certain expira-
tion date, having speci-
fied senses and so on.

These are all useful
features, but what really
makes jVLT stand out
from the crowd is its
Examples section.
Basically, jVLT allows
you to add example
sentences and link
them to the words in

the database. In this way, you can not only record the words’ meanings, but
also their real-life usage. To add a new example sentence, click on the
Examples tab and press the Add button. Enter the example and its transla-
tion in the respective fields. To link the example to a word in the database,
select the desired word in the example sentence. This displays the word and
its senses in the lower part of the window. By default, jVLT displays the exact
matches to the selected word. This means that if you want to connect the

verb connu to its infinitive form connaître, you have to edit the word manu-
ally in the Filter field. Next, select the sense you want and press the Add but-
ton. The clever bit is that you can link multiple words to the same example—
provided, of course, that these words are in the example sentence. When
you are satisfied with the result, press OK.

Now that you’ve added the words, you are ready to start memorizing
them using jVLT’s Quiz section. This part is loosely based on the selective
learning system proposed by German psychologist Sebastian Leitner in the
1970s. The purpose of this system was to make learning using flash cards
more efficient and less time consuming than the traditional method. Leitner’s
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Figure 3. Using filters, you quickly can find words
that match the defined criteria.

Figure 4. The Examples section lets you add example sentences and link
words to them.

Figure 2. Adding a Word to the jVLT Vocabulary Data
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system divides flash cards into groups, and how often you review the
cards in a group depends on the group’s level of difficulty. In jVLT, all the
words are placed in different batches. During a quiz, words are moved
into a “higher” batch if you know the word. Moreover, the word becomes
inactive for a predefined period of time, meaning that it will not appear in
the subsequent quizzes. The word is re-activated once its inactivity period
has expired. It may sound a bit complicated, but jVLT hides all the theory
behind a user-friendly interface.

Before you start a quiz, you can decide whether you want to include all
the words in the database or only a subset of them. This feature can come in
handy if you want to brush up on words from a particular category or lesson.

For example, if you are planning to eat at a restaurant, you might want to
go through all the words in the Food category. To do this, press the Select
words button and define a filter. During the quiz, jVLT displays the word’s
senses first, and your task is to provide the corresponding word. When you
press the Next button, jVLT shows the word, and if your guess was correct,
answer Yes to the “Did you know it?” question; otherwise, answer No. Once
you have completed the quiz, jVLT displays some statistics, including your
success rate and the number of words in different batches. You can use this
information to monitor your overall progress, but don’t focus on it too much.
The most important thing is that jVLT ensures that you learn more efficiently.

STARDICT
A good dictionary is an indispensable tool when you are learning a 
foreign language, and if you need a solid dictionary application, look 
no further than StarDict (http://stardict.sourceforge.net). This seemingly
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Figure 5. Use the Quiz section to test your knowledge. Figure 6. StarDict is a dictionary program that sports a couple of clever features.
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simple application hides quite a few useful features that can help 
you look up words and translate texts quickly and efficiently. StarDict 
is available with most mainstream Linux distributions. For example, 
to install StarDict on Ubuntu, you simply can use the Add Programs
manager (you may be prompted to enable the Universe repository 
in order to install StarDict). StarDict can also be run via klik 
(http://stardict.klik.atekon.de), so you can try it without actually
installing it on your machine. Before you launch StarDict, you have to
add some dictionaries to it, and StarDict’s Web site provides a compre-
hensive list of the available dictionaries. Simply choose the dictionary
you want, download its tarball version and unpack it using either an
archive manager or the tar -xjvf dictionary.tar.bz2 command,
where dictionary is the exact file name. Move the resulting archive

using the following command:

mv dictionary /usr/share/stardict/dic

Using this procedure, you can install as many dictionaries as you like. You
can use StarDict’s dictionary manager later to enable and disable the installed
dictionaries as well as to change their order.

Launch StarDict, and start using it by entering the desired word into the
search field. As you type, StarDict displays a list of possible matches from
all the installed dictionaries. You also can look up the word using several
Web search engines and on-line dictionaries, such as Google, Yahoo!, LEO
and so on. To do this, right-click on the Internet search button, and select
the search engine you want. Better yet, if the desired search engine is not
on the list, you easily can add it. To do this, press the Preferences button,
select the Main window→Search Web site, and add your search engine.

StarDict also allows you to perform so-called fuzzy queries, which can be
rather useful when you don’t remember the exact spelling of the word. To
run a fuzzy query, use a slash (/) before the search word. StarDict utilizes the
Levenshtein distance (http://en.wikipedia.org/wiki/Levenshtein_distance) to
find the possible match to the search word.

StarDict also sports another nifty feature called Scan. When it’s enabled,
select a word in any application, and StarDict displays its translation in a pop-
up window. This lets you look up words quickly when you, for example, read
Web pages in Firefox or view documents in OpenOffice.org.

FINAL WORD
No matter how clever the language applications are, it’s ultimately you who
has to do most of the work. However, language tools like jVLT and StarDict
can make the learning process more effective and fun.�

Dmitri Popov is a freelance writer whose articles have appeared in
Russian, British and Danish computer magazines. His articles cover
open-source software, Linux, Web applications and other computer-
related topics.
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Figure 7. Using the Scan feature, you can look up words from within
any application.
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In the early days of the World Wide Web, Web
pages were created by hand. Although this approach
still may appeal to some, I think most of us would
prefer to see our Web page as we create it.

In fact, several programs, most of them quite
expensive, exist that help you create nice-looking
Web sites graphically. Back in Netscape’s heyday, a
free Web site editor was built into the old Mozilla
browser suite, but it was abandoned when the
Mozilla development stopped. Now, thanks to
some enterprising programmers who resurrected
the old Mozilla code, we have Nvu.

Nvu is short for new view. Think of Nvu as a
word processor for Web pages. It helps you—
quickly, easily and graphically—create attractive
Web pages and entire Web sites.

The easiest way to get Nvu is through your dis-
tribution’s package manager. For example, on my
home computer, which runs Ubuntu, I simply
launched the Synaptic package manager, searched
for nvu, selected it, and then pressed the Apply
button. After the install, I found it sitting in the
Applications→Programming menu.

If you can’t find Nvu in your distribution’s pack-
age manager, go to http://www.nvu.com and click
on the Downloads link to find several packages
that are suitable for many different distributions.

When you first launch Nvu, you are presented
with what essentially amounts to a blank canvas.

This blank sheet can be daunting, but creating
Web pages with Nvu is surprisingly easy. To
demonstrate a little of what it can do, let’s create
a simple Web site.

I recently took my family to the beach, and the
grandparents have been pestering me for the
photos, so that seems like a natural place to start.

When it comes to creating a Web page, the
sky is the limit. Because this is a small site, I’m
going to try to keep things simple. The first thing I
want to do is set up a couple of tables, one inside
the other, to hold my pictures and text. Think of
tables as little boxes that you can put stuff into.

There is a fancier way of laying out a Web site,
called Cascading Style Sheets, and Nvu supports
it, but for simple sites it seems like overkill. Tables
have been used for years for basic Web page lay-
out tasks, and they are quick and easy to set up—
exactly what I need.

To create a table in Nvu, click on the Table
menu and choose Insert→Table. A dialog box
pops up with a 6x6 grid on it. To create a table,
simply move the mouse around the grid, and click
when you have the appropriate number of rows
and columns highlighted.

The first table I want to create is simple—two
rows with a single column. I highlight them, as
shown in Figure 3, and click OK with my mouse.
Presto—I have a table.

Before moving on to the second table, I want
to make sure to hide the borders of this table.
Because I’m using the table for layout, I do not
want the table border to be seen. To change the
visibility of the border, I click inside one of the cells,
and then click on the Table button in the toolbar.
The Table Properties window opens, and under the
Table tab, I set the border to 0. As the rest of the
settings are fine, I click the OK button. The border

CCrreeaattiinngg  WWeebb  PPaaggeess  wwiitthh  NNvvuu
In this tutorial, Daniel Bartholomew uses Nvu to create a small Web site for viewing family pictures.
The Nvu Web site editor provides what you see is what you get (WYSIWYG) editing in Linux.

DANIEL BARTHOLOMEW

Figure 1. Nvu Ready for Action

Figure 2. Creating a Table

http://www.nvu.com
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can be set to any number you want, from zero up.
After setting the border to zero, you will notice

that the table is represented by colored lines instead
of black lines. Don’t worry; they won’t show when
you view the page in your Web browser.

Now, on to the second table. I want this table
to be nested or placed inside of the other table,
inside the bottom cell to be exact. To do this, I
simply click inside the bottom cell, and then go to
the Table menu and choose Insert→Table as I did
when creating the first table.

I have six pictures that I want on this page,
with some text about each picture, so for this
table, I want six rows and two columns. I highlight
the appropriate boxes until it says 6x2 and then
click OK. I then select my new table and set the
border to zero as I did with the first table.

If you’ve been following along, your Web
page should now look similar to the one shown
in Figure 5.

Before moving on, I want to save my Web
page. I want to do this for two reasons. First, sav-
ing often is a good thing to do. Second, Nvu likes
to know where the things are in relation to each
other; otherwise, it has to guess, and it can make
mistakes. Until we save the file, the changes I
have made do not really exist.

When I was getting ready to create my Web
page, one of the first things I did was create a
folder to hold all of the files. Unlike a word-pro-
cessing document, items on a Web page are not
necessarily in the same file. The text and layout
portion of the Web page are in the HTML file, and
the images, movies and sounds are in separate
files. For a large Web page, this can mean hun-
dreds of files. I don’t plan to have quite that
many, but to keep things neat and tidy, I always
create a folder to put everything in.

Because my Web page is about a trip to the
beach, I called the folder beach. I put the selected
beach photos in the folder I had prepared, along
with a title picture and a picture I prepared to use
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Figure 3. Defining My Table Dimensions

Figure 5. My Finished Tables, One inside the Other

Figure 6. Images for My Web Page

Figure 4. Setting Other Table Options
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as the background. Having title and background
pictures is not necessary, but they can make
things look nice. All of the pictures were prepared
using The GIMP image editor included with most
Linux distributions.

One thing to be aware of when preparing
images for the Web is that, straight from your
digital camera, most pictures are far too large to
present comfortably at full size on a Web page.
For my images, I opened them in GIMP, went to
the Image menu and chose the Scale Image...
option. I then resized them to a comfortable
320x240 pixel size. I also made other modifica-
tions to make them look nice. When preparing
your images, experiment on a copy of your
images until you get results you like. I prefer to
save my images in the PNG format.

Back to the task at hand—to save my Web page,
I click on the Save icon. The first thing that happens
is a window pops up asking for the Page Title. This
is a necessary part of every Web page. I just put in
“A Day at the Beach”, and then click OK.

Now that I’ve gotten the title dialog out of the
way, a normal save dialog appears. I navigate to the
beach folder, put in a file name of index.html and
click the Save button. The reason I name this file
index.html is because that is what most Web servers
expect the first file of a Web site to be named.

Now that I have saved my page, it is time to
add my title picture. To do this, I first select the
cell where I want it to appear (the big one on top)
by clicking inside the table cell, and then I click
the Image button.

Next, I click on the Choose File... button and
see the Select Image File dialog, shown in Figure
10. Don’t worry about the index.html file not
showing up; this dialog shows only image files by
default. From here, I select my header.png image
and click the Open button.

After selecting the image file, I am redirected
back to the Image Properties window. I enter
some alternate text for the image and then click
the OK button. Alternate text is displayed while
the image is loading or if images are turned off. It
also is used by screen readers and other tools for
people with disabilities, so it is always a good idea
to put it in and make it descriptive.

Now that I have my title graphic in place, I can
put in all of my other pictures. The process is the
same as for the title graphic. I first select the cell
where I want the picture to be and then click on
the image button and so on.

You may notice after putting the first picture in
the nested table that the column it is in expands
to fill the screen. The other column is still there,
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Figure 7. Setting the Title of My Web Page Figure 10. Choosing an Image

Figure 8. Saving My Web Page

Figure 9. Getting Ready to Insert an Image
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but it has been pushed to the side. Simply scroll
sideways until you find it, select the cell for the
second picture, and insert it as before. After you
have pictures or other content in both columns,
the cells will even out.

After placing all of my pictures, I noticed they

were not centered in their cells, so I centered
them by first selecting the picture by clicking on it
and then clicking the Align Center icon (Figure
14). It works like the equivalent icon in
OpenOffice.org and other word processors. In
fact, the other icons in the toolbar that you may
recognize work similarly to what you would
expect from working in a word processor.

I now have placed most of my pictures—all
except the background picture. To place this one, I
choose Page Colors and Background... from the
Format menu. From the Page Colors and
Background window, I can set the background
color of the page, link colors and more. I’m inter-
ested only in the background image at this point,
so I click the Choose File... button, select the file,
click on the Open button and then the OK button.

Now things are starting to look the way I want
them. I put in my text, save the file, and I am basi-
cally done. Figure 17 shows what the site looks
like in Firefox.
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Figure 11. Setting Image Properties

Figure 12. The Image Is Now Inserted

Figure 13. Selecting the Correct Cell to Insert the
Third Image

Figure 14. Centering the Image in the Cell

Figure 15. Setting the background image 
is done here.
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All that is left for me to do is add some links
and then put it on the Internet.

Links are those (usually) blue underlined words
that take you from place to place on the Internet.
Nvu makes adding links easy. Simply highlight the
text you want to turn into a link, and then click
the Link button. If you are linking to another
HTML or other file in the page folder, simply enter
its name and click on the OK button. If you are
linking to another Web site, enter in the URL
(don’t forget the http:// part). And, if you are put-
ting in an e-mail address, make sure you check
the indicated check box.

The final step in creating a Web page is to
publish it. To publish a site from Nvu, click the
Publish button. It then prompts you for the set-

tings it needs to copy your files to the server.
Filling in this information can be the most difficult
step. Most ISPs provide customers with space on
their server to put up Web pages. Contact your
ISP for help in filling in this information.

That’s it for now. If you’ve been following

along, congratulations! You’ve just created your
own Web page! Now play around, add to it and
create your own Web site.�

Daniel Bartholomew has been using
computers since the early 1980s when
his parents purchased an Apple IIe.
After stints on Mac and Windows
machines, he discovered Linux in 1996
and has been using various distributions
ever since. He lives with his wife and

children in North Carolina.
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Figure 16. The Page Colors and Background Dialog

Figure 17. The Newly Created Web Page

Figure 18. Adding a Link to a Second Page

Figure 19. Publishing My Web Page

RESOURCES
A lot of resources are available on-line to help you
learn more about Nvu. Here are some of my favorites:

WebBriefcase: http://www.webbriefcase.com.au/
categories/how-tos/nvu

Designing & Publishing a Site with Nvu, by
Christopher Heng: http://www.thesitewizard.com/
gettingstarted/nvu1.shtml

Introduction to Nvu: http://learn.dccc.edu/~lori/nvu

forum.nvudev.org: http://forum.nvudev.org

http://part
http://learn.dccc.edu/~lori/nvu
http://forum.nvudev.org
http://www.webbriefcase.com.au/categories/how-tos/nvu
http://www.thesitewizard.com/gettingstarted/nvu1.shtml
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In the course of my day, I generally use a wide variety of desktop envi-
ronments. Although I spend most of my time in KDE, I do use GNOME,
Microsoft Windows and Apple’s OS X on an almost daily basis. When
using these other environments, I realize just how much I’ve come to
depend on Konqueror to simplify my work flow. I try to type fish:/ URLs
into Apple’s Finder. I am momentarily confused when a quick Alt-F2
media:/ fails to work as expected in GNOME. I feel downright lost in
Windows without help:/. I guess I need to accept the fact that I’m
addicted to KIO.

Kioslaves are plugins that extend functionality all over KDE. They can be
accessed through every standard file dialog, as well as through Konqueror
and the run command box. They form the core of Konqueror’s functionality
as both Web browser and file manager. You probably already use kioslaves
without realizing it, as Konqueror’s HTTP and FTP functionality is implement-
ed through KIO.

SYSTEM
The system kioslave is, in essence, a meta-kioslave. To access the system
kioslave, type system:/ into the Konqueror address bar. From here, you can
access the Home, Remote, Media, Trash and Users kioslaves.

HOME
The Home kioslave takes you to your home folder, and the Users kioslave
shows you the home directories of other users on the system. This allows
you to manipulate files in home directories of other users who might have
chosen to give permissions for others to read or modify.

REMOTE
The remote places kioslave (accessed directly with remote:/) allows you to

browse files on remote hosts using Microsoft Windows SMB file sharing,
NFS, Bluetooth and SSH, all through the familiar Konqueror interface.

The Add a Network Folder wizard helps you create a shortcut to a
network share you plan to access often. To create a shortcut, click Add a
Network Folder, and select the type of network share you would like to
access. Click Next, and then fill out the details in the provided form. If
you have left the box Create an icon for this remote folder ticked, a
shortcut to this connection appears in the remote:/ kioslave window.

KKoonnqquueerr  YYoouurr  FFiillee  MMaannaaggeemmeenntt  wwiitthh  KKIIOO
K Input/Output libraries, or kioslaves, are favorite features for most new KDE and Linux users.

JES HALL
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Figure 1. My Home Network, Showing Various SMB Workgroups
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MEDIA
The media kioslave lets you access storage media in a user-friendly manner.
On recent KDE versions, support for the hal + dbus back end allows for
removable devices to be displayed and accessed dynamically without the
need to resort to the command line. CD and DVD media can be accessed
through media:/, as well as USB Flash keys, MP3 players, cameras, hard
disks and any other device that acts as a generic USB storage medium.

TRASH
The trash kioslave in KDE versions 3.4 and greater provides a freedesktop.org-
compliant trash protocol for KDE applications. This specification supplies
some nifty new features.

Previously, if you trashed two files with the same name, the older file
would have been overwritten. Now, thanks to the enhanced trash stan-
dard, KDE trash supports trashing of multiple files with the same name.

For example, if you had trashed two revisions of the same file or two files
with the same name from different locations on the disk, they will both
show up in the trash. To see what time the file was trashed or where it
came from, right-click on the file, and select Properties. The Meta Info tab
shows the time and date the file was deleted and its original location in
the filesystem. To restore the file, right-click on the file and select restore,
or simply drag the file out of the trash into any other directory in the
Konqueror file manager.

SETTINGS
The settings kioslave (settings:/) provides a simplified view of system
settings—a little like the Microsoft Windows’ control panel. All of the
configuration options from the KDE Control Center can be found here.
One advantage to using this view of the KDE Control Center is that you
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Figure 2. The Media Kioslave, Showing Various Types of Removable Media Figure 3. The Trash Kioslave, Showing Two Files with the Same Name in
the Trash
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can create a shortcut on your desktop to an often-used settings dialog
by dragging the icon to your desktop and selecting Link here.

AUDIOCD
The audiocd kioslave is a favorite of mine. If the correct libraries and codecs
are installed, audiocd:/ lets you rip and encode to Flac, Ogg or MP3 by drag
and drop. It doesn’t get much easier than that. KDE even queries on-line
CD databases to fill in the album, artist and track names for you.

Dragging and dropping the folders entitled
MP3, Ogg Vorbis or FLAC lets you get the entire
CD or any individual track. To rip the entire CD
as a single file, drag and drop the encoding you
prefer from the Full CD folder.

You can tweak the quality settings of MP3
and Ogg encoding in the KDE Control Center
as well as the format of the file names.
Navigate to Sound & Multimedia→Audio CDs,
and adjust the settings accordingly. Here you
also can set the default CD device if you have
more than one.

HELP
The help kioslave is a simplified help browser for
the KDE desktop. Typing help:/kappname into the
Konqueror address bar displays the help documen-
tation for that application. Incidentally, typing
help:/kioslave lists the installed kioslaves on the
system and lets you access the help files for those
that are documented.

Many more kioslaves exist than are detailed
here. To see a full listing, type help:/kioslave
in any Konqueror window or in the run com-
mand box, or navigate to Protocols in the KDE
Info Centre. Many KDE add-on applications
install their own kioslaves, and user-contributed
kioslaves can be found at http://kde-apps.org.�

Jes Hall is a Systems Administrator and open-source developer
from New Zealand. She’s passionate about helping open source
bring life-changing software and information to those who
might otherwise not have them.
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Figure 4. The Audiocd Kioslave, Ripping and Encoding a CD to Ogg Vorbis Format
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Hunting for information and knowledge on the Web is often entertaining.
Although, I’m sure all of us feel embarrassed about how much time we
waste looking for interesting stuff to read. This month, TUX is Konquering
the Web, and a big part of that is increasing your productivity. I readily admit
spending far too much time surfing various news and information Web sites
to get my daily dose of current events. So, to make more time for real work,
I installed RSS readers and put them to my daily efficiency tests.

NOT ENOUGH TIME?
My business needs up-to-date information on current industry events. I have
a small cadre of Web sites I typically examine for interesting tidbits of infor-
mation. Just like everyone else, I’m often lured by some unrelated headline
or story posted to the main body of the site and soon find myself surfing the
Web instead of using it for my benefit.

In short, RSS readers surf preselected Web sites, looking for new events
that interest you. This way, you don’t need to start your browser to read the
latest news. Instead, the RSS reader focuses your attention in a “what you
see is what you need” (WYSIWYN) format.

After defining preferences, the information brought into the reader con-
tains only relevant text for your interests. You even can search through these
predefined feeds and find specific information to reduce search and scanning
time further. If you are a hard-core Web surfer, you may find it boring to
read news feeds without all of the usual graphics presented; however, if
needed, most RSS readers include browser links to the full site. Sometimes
they even include graphics to spice up appearances.

WHICH ONE TO CHOOSE?
There are several well-known Linux RSS readers on the Web. In fact, TUX
[http://www.tuxmagazine.com/node/1000127] suggests seven RSS readers you
can use to get feeds from the magazine Web site. Blam!, Liferea and RSSOwl
get a lot of attention on the Internet, so we’re focusing on them in this article.

BLAM!
This reader is one of the projects listed on Imendio’s Web site at
http://developer.imendio.com/wiki/Blam. Blam! is a streamlined news
reader, enabling you to track an unlimited number of news feeds. The
user interface is plain and organized like a typical e-mail program.

On initial start-up, Blam! displays various sample news feeds so you have
an idea of how the reader works. Simply click the Refresh All button at the
bottom left of the screen, and the feeds begin to populate with data. When
updated, click on the feed, and then scan new items posted to the site.

To add a new RSS-enabled site, go to Channel→Add or press Ctrl-N.
Blam! presents a URL window, so you can type or paste the feed location.
I’ve found copying the feed location directly from the browser is best. For

LLiinnuuxx  RRSSSS  RReeaaddeerrss::  BBllaamm!!,,  LLiiffeerreeaa  aanndd  RRSSSSOOwwll
Really simple syndication (RSS) provides an effortless way to pull content
from Web sites and read at your leisure with one of these Linux applications.

DONALD EMMACK

Figure 1. The Blam! RSS Reader Main View

http://www.tuxmagazine.com/node/1000127
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example, to add the RSS feed from TUX, open http://www.tuxmagazine.com.
Then, right-click on the RSS logo on the bottom left and copy the location.
Paste the location in Blam!, and it loads the latest and greatest TUX posts for
you to enjoy. Blam! includes a link to related graphics in the detail window.
To see them, simply click on the link to open it in your browser.

LIFEREA
SourceForge hosts Liferea at http://liferea.sourceforge.net/index.htm. At first
glance, it’s easy to see why Liferea gets so much attention on the Web. The
layout and user feel is similar to Blam! However, Liferea adds function but-
tons at the top of the screen, providing easy access to frequent tasks like
adding and manipulating feeds.

By default, Liferea has several feeds already set up for your review.
Adding a new feed is simple. Click the + icon, and insert the URL to the
RSS-enabled site and you’re done. Again, I copied the RSS location from
TUX and quickly added it to the reader feed list.

Unlike Blam!, Liferea presents graphics embedded in the feed data.
Clicking on the graphic opens the linked location in your selected browser.
Another nice feature is the ability to search through the feeds, looking for
only the information you want.

Under Program→Preferences, users can define several software features,
such as cache handling, folder preferences and browser selection. An opti-
mization setting manages memory by keeping feed contents in memory or
loading them from disk.
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Figure 2. Adding a New Feed to the Blam! RSS Reader

Figure 3. Adding a New Feed to the Liferea RSS Reader

Figure 4. The Liferea RSS Reader displays an image embedded in a
news item.
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RSSOWL
Java-designed RSSOwl is different because it is platform-independent and
runs on Windows, Linux and Mac (http://www.rssowl.org). After installation,
RSSOwl starts and includes many preset feeds separated by category.

Like Blam! and Liferea, adding new feeds is easy. Select the new button
at the top of the screen, and input your selected URL and description. Once
again, I added TUX to the feed list, refreshed the feed, and now the most
current news from TUX is on my machine.

RSSOwl boasts features not found in other programs, such as feed validation
and the ability to import blogroles (a collection of feeds) into the program.
Personally, my favorite feature is the ability to view the selected feed in PDF for-
mat. This feature is often handy for passing out news items in hard-copy format.

Similar to the other applications, RSSOwl looks like an e-mail application.
Although, you can change the windows’ layout in Tools→Preferences, along
with other program features to suit your taste.

THE TAKE AWAY
Until last year, I didn’t care much about RSS readers. But, the volume of
information I sort through for current events expands daily. Thus, the num-
ber of sites I must look through presents the temptation to surf and waste
time reading stories that kill productivity.

Like everyone else, it’s sometimes relaxing to wander around the Internet.
But, using the RSS reader saves valuable time. Each of these applications has a
healthy following of devoted users. Ranking the best one is tough and beyond
the scope of this brief review (maybe we will dig deeper in a future issue).

My choice—I use Liferea, because it has a balance of features, and my
distro includes it in the base application set. That said, each of the readers
introduced here get the job done.�

Donald Emmack is Managing Partner of The IntelliGents & Co. He
works extensively as a writer and business consultant in North America.
You can reach him at donald@theintelligents.com or by cruising the 2
meter amateur RF bands in the Midwest.
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Figure 5. A Detailed Illustration of the RSSOwl RSS Reader Main View

Figure 6. Adding a New Feed to the RSSOwl RSS Reader
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Since 1994, Linux International (LI) has been a friend of Linux and vendors
wanting to use the Linux operating system. Founded by Patrick D’Cruze 
of Australia, the organization very quickly spread, with the help of several
US-based companies, and became a worldwide association. Its original focus
was helping companies accept Linux as a commercially viable operating
system, thus creating a sense of community around the commercialization
of free and open-source software.

Some of Linux International’s achievements up to this point have included
the creation of the Linux Mark Institute (http://www.linuxmark.org) to pro-
tect the public and Linux users of the world from unauthorized and confus-
ing use of the Linux mark and to issue proper licenses to authorized users of
the Linux mark. It also raised awareness of the importance of allowing appli-
cations to work across distributions. These efforts led to the formation of the
Free Standards Group (http://www.freestandards.org). The Free Standards
Group is a nonprofit organization dedicated to accelerating the use of
free and open-source software by developing and promoting standards.
Key Free Standards Group projects include the Linux Standard Base (LSB)
and OpenI18N, the internationalization initiative.

Finally, LI recognized the need for certification for Linux system
administrators, and it helped form the Linux Professional Institute
(http://www.lpi.org). LI funded the creation of the initial test evaluation,
helped promote certification and participated on its advisory board.

Together, all of these achievements, and many years work as consult-
ants and promoters of Linux user groups, prove that LI is one of the 
reasons we all enjoy a vibrant economy surrounding Linux. LI recognizes
that much has been accomplished, but there is still much more to do.
However, it believes the needs of the Linux community have changed.

Back in 1994, LI witnessed hardly enough end users of Linux to create an
end-user organization; now it sees more than 60-million Linux systems
worldwide. So, as TUX magazine foresaw more than a year ago, it too
will turn its focus to Linux end users. Through a vote by the LI board of
directors, LI will become an end-user organization.

Currently, Linux International is completing a massive change in its home
page (http://www.li.org), which should be finished by the time this issue is
published. Currently, the Web site offers little explanation about its new
direction or the structure of the reformed organization, except for a brief
definition of an end user. An end user is a person who uses free and open-
source software on a daily basis. To learn more about the Linux International
change and what lies ahead for Linux, I sat down with one of the leaders
of Linux International, Jon “maddog” Hall, during LinuxWorld Toronto,
late in April 2006.

I began by asking for more information regarding the new focus, and Hall
immediately started by contrasting with what it was like in the beginning.
According to Hall, Linux International was originally a vendor-oriented organ-
ization helping Linux get started. LI simply worked with vendors wanting to
market Linux, and it became very successful in achieving that goal. However,
after the many achievements and the strong growth of Linux, LI noticed the
growing need from end users of Linux. Although details are forthcoming on
the Web site, Hall offered a few hints as to the organization of the new LI.
First, no corporations will be voting members. Employees of those corpora-
tions can join as corporate members; however, they will have only the same
rights as any other member.

Our conversation naturally flowed into a discussion of some of the
obstacles preventing more end-user adoption of Linux. Hall was quick to

IInnttrroodduucciinngg  tthhee  NNeeww  LLiinnuuxx  IInntteerrnnaattiioonnaall::  
aa  TTaallkk  wwiitthh  JJoonn  ““mmaaddddoogg””  HHaallll
Linux International, Jon “maddog” Hall and TUX focus on end users to usher in the next wave of Linux world domination.

KEVIN SHOCKEY

http://www.linuxmark.org
http://www.freestandards.org
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note that a lack of applications was one of the critical obstacles. He also
quickly refuted a commonly identified obstacle—that Linux is hard to use.
To demonstrate his point, he conjectured that if you were to put people
who had never seen either Windows or Linux in front of two computers
(one with Linux and the other with Windows), they would find them
both equally easy to use.

Our discussion of applications included talking about what it would
take for companies like Adobe, Quicken and AutoCad to port their popu-
lar applications to Linux. On this topic, Hall pointed out clearly that if the
volume of sales was evident, vendors would take notice. He repeated,
“It’s all about volume!” We finished our discussion of applications with
one final admonition from Hall. When asked for recommendations for
application developers, he strongly suggested that they needed to pay
more attention to the Linux Standard Base so that an application can be
used easily across distributions.

My final question for Hall was, what is the next big challenge for Linux.
Once again, there was little hesitation when he told me he believed the next
challenge to Linux would be fighting back the next set of products from
Microsoft. He feels that with these products, Microsoft will mount a large
campaign to fight the Free and Open Source Software movement. Digging a
little deeper, he shared that Microsoft will likely continue the fear, uncertainty
and doubt (FUD) campaigns it has used so successfully in the past.

Hall went on to justify this perspective by noting that the entire informa-
tion technology industry was moving from a product to a services economy.
He pointed out that considering this trend, the future doesn’t look good for
Microsoft, because it lacks any real service-based business model. Putting
these comments together, it would seem that because Microsoft will not be
able to grow any significant services revenue, it will have to fight for every
licensing dollar it can get. Of course, this does not factor in any unforeseen
acquisition by Microsoft, made possible by its significant cash reserves.

To exemplify Hall’s last point further, a couple days after I interviewed
Hall, Microsoft announced that it was investing $2 billion of its 2007 fiscal
year profits in research and development to pump up its software as service,
advertising and MSN businesses. Many analysts, including close personal
friend and information technology consultant Francisco Martinez, used this
announcement to point to Microsoft’s lack of faith in its licensing revenues.
All of these events seem to confirm Hall’s perception that Microsoft may be
in trouble. With the Vista release dragging into 2007, Microsoft can only

hope to slow the advance of free and open-source software by ramping
up its expenditures on FUD. That my dear readers, as Hall predicts, is the
proverbial shoe we are waiting to hear fall.�

Kevin Shockey is Editor in Chief of TUX.
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Xandros is designed with the former Windows
user in mind. Recognizing the fact that certain
Windows programs are not yet available for Linux,
Xandros takes the extra steps necessary to enable
the dual-boot option so those programs can still
be run via Windows, while defaulting into
Xandros for all else. With the addition of
CrossOver Office, some Windows programs can
run directly from the Linux desktop with no
Windows installation necessary. In addition, the
entire Xandros desktop experience is reminiscent
of Windows, so very little time is needed to learn
a new operating system. The Xandros desktop
and included applications are tweaked to work
perfectly, each and every time, without exception.
With Xandros there is no need to straddle the
fence of indecision any longer. Don’t delay—take
that important first step.

If you’re confused over the current deluge of
Linux distributions, join the club. Some distribu-
tions cater to techno-geeks who have experience
in optimizing their systems and time on their
hands to configure everything themselves. Others
aim at newbie Linux users who are taking their
first steps into the wonderful world of Linux. It is
not always easy to take that first step, and some
would-be Linux users are hesitant to take the
plunge, choosing instead to test the waters. What
is it that keeps these fence-straddlers from using
Linux? Certainly, they know that Linux is a far
more secure operating system with virtually no

viruses or spyware to attack it, yet still they remain
hesitant. The reason so many refrain from using
Linux is directly related to the fact that one or
more Windows programs they have grown accus-
tomed to are not available for Linux. So, is there a
Linux distribution designed for the new Linux user
that plays nicely with Windows? Yes, there is. The
subject of this review is the Xandros 3 Deluxe
Linux desktop, which can repartition your
Windows drive to make room to install itself, leav-
ing all Windows files intact and unharmed. What
is more, Xandros Deluxe includes a program that
actually allows some Windows programs to run
from the Linux desktop! The Xandros motto is
“making Linux work for you”, and if you are one
of the numerous fence-straddlers out there,
Xandros is speaking to you.

INSTALLATION
Xandros is certainly one of the easiest Linux instal-
lations we have ever encountered. The entire
process takes less than 30 minutes in four quick
and easy steps. We attempted a dual-boot install
where Xandros makes room from an existing
Windows partition, and we were successful in our
venture. This repartitioning works for both FAT-32
and NTFS-formatted drives. With a dual-boot
install, the user is presented with a boot screen to
select either Xandros (default) or Windows. This is
a great feature for beginning Linux users who
want to dip their feet into the pool but are not

quite ready to swim. Many Windows users fit into
this category and have been unwilling to use
Linux, because one or two programs available on
the Windows platform are not yet available for
Linux. With this dual-boot option, the problem
is solved. Boot into Windows for those special
programs and into Xandros for all the rest.

Although Xandros was able to detect and con-
figure all of our test hardware properly, no Linux
distribution is able to detect and utilize every
piece of hardware that is out there. This is not a
Xandros-specific problem. Neither is it a Linux
problem. The problem lies with narrow-minded
manufacturers refusing to write Linux drivers for
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XXaannddrrooss——AA  FFiinnaall  LLooookk  bbuutt  NNoott  tthhee  LLaasstt
The Xandros Desktop OS Version 3 - Deluxe Edition targets users that want the best of both Linux and Windows on one machine. With special
features and the inclusion of CodeWeavers CrossOver Office, Xandros Desktop excels at providing Windows compatibility. JAY KRUIZENGA

Figure 1. Register your copy of Xandros to enable
support.
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their respective hardware. So, it is best to check
the Xandros Web site and Xandros forums for
support in this area. No matter which Linux distri-
bution you choose to install, you are going to
have to do a little homework first. If in doubt,
post your system components on the Xandros
User Forums for a compatibility check.

The entire graphical installation process is
detailed in a step-by-step manner in both the
User Guide and the Getting Started Guide (to
be discussed later).

After installation and the initial boot, you are
presented with the First Run Wizard enabling you
to configure your mouse, select regional (lan-
guage) settings, make certain date and time are
correct, add printers and select system behavior
(default is Windows-like but this can be made to
resemble Mac and others if you so choose). You
also will be prompted to register your copy of
Xandros, which is recommended so that you can
receive your e-mail support and appropriate
updates via the Xandros Networks.

Installation: good

EASE OF USE/CAPABILITY
Xandros exclusively uses the KDE 3.3 desktop with
a little Xandros tweaking so that everything works
as it should. What you will not find in Xandros is a
hodge-podge of multiple programs, but the very
best chosen applications modified so they work
reliably and consistently every time. This does limit
the number of applications installed by default,
but Xandros has the capability of installing any
.deb or .rpm file through Xandros Networks, so
you are definitely not limited by any means.

Included with Xandros 3 are the following
apps: Firefox 1.07, for the ultimate tabbed brows-
ing experience minus pop-up ads; Thunderbird

1.07 with intelligent spam filtering; Skype 1.1
for secure encrypted computer-to-computer
calls; an instant messenger service that allows
connection to MSN, Yahoo, AOL, ICQ and
Jabber; GIMP 2.0 for editing and manipulating
images; OpenOffice.org 1.1, compatible with
Microsoft Office; RealPlayer 10, for streaming
audio and video; and much more.

Xandros Networks (XN) enables the user to
install numerous applications from the Xandros
servers. Some of these applications are available
only to paid Xandros Premium Members (annual
cost $39 US). For instance, StarOffice 8, which
retails for $69.95 US, is available to Premium
Members at a special discounted price of only
$29.95 US, and it installs with one click. Other
exclusive applications for Premium Members
include KOffice, amaroK, Quanta Plus, Quake 3,
Unreal 2004, Inkscape SVG vector illustrator,
OpenOffice.org 2 (boxed set comes with 1.1) and
Xandros Antivirus (again, all tweaked to work
perfectly with Xandros).

In addition to the Premium Membership,
numerous free applications are available to 
all registered members. Simply sign in and click
to install.

XN allows the installation of any .deb or .rpm
file (but these do not include support from
Xandros). You can point XN to the unsupported
Debian repositories to search for and install a
large number of applications from these sites.

Although XN is quite easy to use, our only
fault was the limited number of applications avail-
able, especially for paying Premium Members. The
technology is in place, but the Networks could be
so much more than it presently is.

The Xandros File Manager (XFM) is the propri-
etary component of Xandros that makes it unique
from all other distributions. Many people mistake
the XFM as an optimized KDE Konqueror, but it is
not. XFM was built from scratch long before
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Figure 2. The Default Xandros 3 Deluxe Desktop

Figure 3. Browse pictures with XFM.
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Konqueror existed, and what an awe-inspiring
tool it is. With XFM, you can access and search
for files on your computer with thumbnail 
pictures, browse the Net through its internal
browser, create music and data CDs, copy disks,
erase rewriteable disks, and even zip or tgz
archives with simplicity.

It was a snap to rip CDs with XFM. Xandros
does not come with MP3 support, due to licens-
ing restrictions; however, you can install support
yourself through an application called LAME. You
will have to search the Net for this file, download,
and install via Xandros Networks. Supported
formats include Ogg Vorbis and WAV.

CodeWeavers’ CrossOver Office retails for
$39.95 US and is included free with the Xandros
3 Deluxe edition. This is a spectacular program
that allows users to run certain Windows applica-
tions directly from the Linux desktop. No
Windows installation is necessary. With CrossOver

Office you can run Microsoft Office, Adobe
Photoshop, Lotus Notes, Intuit Quicken,
Framemaker, iTunes, browser plugins like
QuickTime and Windows Media Player, and
many more. Unfortunately, most of the supported
applications are older editions than are presently
available. Xandros Networks now has access to
CrossOver version 5.01 with improved support,
and we did not find any way to update this free
of charge; however, a couple of posts on the
Xandros Forums alerted us to the possibility of
contacting CodeWeavers directly with your
Xandros registration number for a free upgrade.
We have not attempted this though, so don’t take
it as gospel truth.

We were able to install our licensed copy of
Microsoft Office XP effortlessly (2003 works
through CrossOver Office 5.01), iTunes 4.9 (only
audio works—no video) and QuickTime and
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Figure 4. It is easy to rip and burn CDs with XFM.

Figure 5. Right-clicking on a file gives you many
options to include zipping files

Figure 6. XFM also acts as a second browser.
Figure 7. CrossOver allows many Windows apps
to run directly from the Linux desktop—no
Windows required.
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Windows Media Player plugins.
Note: the Windows Media Player 
is an older edition that does not
work on most Web sites.

Many other programs are
rumored to work well through
CrossOver Office—check 
the official Web site at
http://www.codeweavers.com
for more details.

All in all, we found the Xandros
experience to be very user-friendly,
an absolute enjoyment to use,
spruced up and tweaked to work
right each time and every time,
which makes this edition a very
wise investment. Simply put,
Xandros rocks! Xandros is very
secure with a built-in firewall 
configurable through the Firewall
Wizard, providing user access 
to keep system files safe from
intruders. In addition, the optional
Xandros Antivirus provides resist-
ance to Windows spyware and
viruses with a program that scans
for malicious files giving you 
the option to delete or quarantine,
preventing their spread to 
non-Linux PCs.

In addition to the above fea-
tures, Xandros has the ability to
network to Windows PCs with
relative ease and the ability to
log in securely to school or busi-
ness via the built-in VPN (virtual
private network).

Peripherals also seem to work

flawlessly. We plugged in our Flash drive via the
front USB slot of our PC, which triggered XFM to
open, detailing the contents of our drive—a very
nice feature. We then were able to drag these
files into our Home folder. Our Hewlett Packard
scanner was picked up and recognized at boot, as
was our USB Plantronics .45 audio headset. Our
wired cable Internet connection was detected at
boot-up, but we had trouble getting our wireless
connection to work.

On another occasion, we plugged in our USB
Fuji camera and again, similar to the Flash drive,
XFM opened and revealed to us the contents of
our camera. It was easy to view our pictures,
select those we desired and drag them to our
Home folder for later editing with GIMP.

Xandros is easy to customize to your own lik-
ing as we did here. The Xandros Control Center
lets you change numerous settings in order to 
customize your Xandros to your unique taste. 
Our custom desktop was created with a child
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Figure 8. Microsoft Office Running through CrossOver Office

Figure 9. Apple iTunes Running through CrossOver Office

Figure 10. Configure the built-in firewall with a
simple wizard.
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taskbar made transparent, resized and centered
below with added icons that we normally would
use on a daily basis.

There is so much more that could be said about

Xandros than space will allow. It is obvious that
the Xandros development team worked hard on
this release, and though it would not seem there 
is much room for improvement (other than addi-
tional hardware support and applications via the
Xandros Networks), the development team is again
hard at work on the future Xandros 4 release.

Ease of use/capability: good

MAINTENANCE
Xandros makes it easy to update applications
through XN. Any type of application or security
update is conducted through XN, making the
entire process relatively simple.

You will know that updates are available if you
see the blue globe on the taskbar turn from a
green check mark to a red exclamation point. Click
on the icon, and XN opens to install the appropri-
ate updates. As a user, you will be prompted for
administrative (root) password for your security
before changes are made to your system.

XN makes it easy to install and maintain
applications running on your system. Simply
one click, and it is accomplished.

Maintenance: excellent

DOCUMENTATION/SUPPORT
Xandros boxed sets come complete with a 350-
page User Guide written in plain English. We
found this guide to be quite exhaustive, covering
every aspect of the Xandros desktop and included
applications. Also accompanying Xandros boxed
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Figure 11. Customize Xandros to your liking.

Figure 12. Change desktop/system settings with
the Xandros Control Settings.

Figure 13. The Xandros Networks makes it easy
to update and install applications.

Figure 16. System changes will prompt for your
administrative password for security.

Figure 15. The Xandros system tray indicates the need to update our system.

Figure 14. The results of updating our system
while using Xandros Networks.
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sets is a Getting Started Guide, covering 
installation and troubleshooting procedures—
excellent documentation with easy-to-follow
step-by-step instructions.

The Xandros 3 Deluxe Edition includes 60 days
of installation technical support via e-mail. Also
included is unlimited access to the Xandros User
Forums where you may find needed answers from
the active registered user base.

Documentation/support: excellent

CONCLUSION
We think you’ll agree that
Xandros provides every-
thing you need for an
extremely enjoyable user-
friendly experience,
where everything works
as it should. Xandros
makes it fun to surf the
Web again, free of worry
over the latest virus or
worm that threatens
Windows users. The ability
to dual boot into either
Windows or Xandros,
and/or to run certain
Windows applications
from the Linux desktop
are both awe-inspiring
additions to Xandros.
These features aid new
Linux users in taking that
first step by giving them
the confidence needed to

get off the fence and finally
use Linux. So what are you waiting for? Put
Xandros to the test. You’ll be glad you did.�

Jay Kruizenga is a former Marine who
started using computers with the
Commodore 64 in the service.
Dissatisfied with Windows, he started
looking for viable options and discovered
Linux in the late 1990s, which he now
uses exclusively for the operation of a

small home-based Internet business.
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SUMMARY

INSTALLATION: good

EASE OF USE/CAPABILITY: good

MAINTENANCE: excellent

DOCUMENTATION/SUPPORT: excellent

PRICE: $89 US

WEB SITE: http://www.xandros.com

HARDWARE TESTED

Hewlett Packard Pavilion 543x

AMD Athlon XP 2200+ processor running at 1.8GHz

Creative Labs Live! Soundblaster PCI card

Generic CD-RW/DVD player

Lite-On CD-RW player

756MB of RAM

Plantronics USB .45 audio headset

Lexar 128MB jumpdrive

NVIDIA GeForce FX 5200 AGP card

Proview 17" LCD monitor

Altec stereo speakers

Hewlett-Packard Deskjet 5440 printer

PS2 Labtec mouse

Wireless USB Hewlett-Packard keyboard

160GB Seagate IDE hard drive
Figure 17. Xandros Running Firefox, Thunderbird and Skype

EXCLUSIVE TUX READER INCENTIVE
If you purchase Xandros 3 between June 15 and August 15, use coupon code 606tux100 to receive a free Xandros 4 upgrade.

http://www.xandros.com
http://www.tuxmagazine.com
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If you’re one of the brave few who have decided
to convert your laptop over to Linux, you’ll run
into one of the same key problems that Mac and
Windows users run into while they’re in the
field—a distinct lack of hard drive space. It doesn’t
take long before the tiny hard drives that come as
standard gear inside most notebooks get filled up
with clutter, whether it’s all of your documents
and applications, your music or even your videos.

Luckily, if your notebook supports USB mass
storage class devices, you’re in luck. A growing
number of higher-capacity portable hard drives
that require nothing more than a USB cable for
both data transfer and power are available. (If
you’re not sure whether your notebook can han-
dle USB mass storage class products, check to see
if it will automatically recognize a USB memory
key. If it does, you’re good to go.)

The big downside with bus-powered external
hard drives is that the drives inside are notebook
drives, which means they’re pricey. The upside is
you’ll have a drive that can tuck away inside your
notebook bag, without the hassle of lugging
along the power cord too.

If you’re paying that much for a device to tote
around your precious data, one thing that may be
worth keeping in mind is how rugged the drive
will be. Almost inevitably, it’s going to take a spill
onto the floor at some point, either because the
airplane hit a bump (the unforeseeable), it fell out
of your laptop bag (the unfortunate) or you forgot

it was connected to your notebook (the just plain
dumb—which I have been guilty of more than
once, I’ll admit).

It’s worth noting that an external USB hard
drive also can be an excellent way to transfer
large amounts of data between Linux, Mac and
Windows machines, so long as you remember to
keep them formatted as FAT32 drives.

PLEXTOR PX-SP08U 80GB 
SHOCK-PROOF PORTABLE HARD DRIVE

http://www.plextor.com
$169 US

There are two ways to protect an external hard drive
from the shocks it will be dealt throughout its career:
internal shock mounting or external padding. The
Plextor series of shock-proof hard drives chose the
latter method, wrapping a silicon bumper layer
around all of the edges of the drive, leaving the long
sides of the drive open for heat dissipation. This
allows the Plextor drive to sport a very small metal
casing—if you don’t need the shock protection, you
can remove the silicon wrap and tuck it into an even
smaller pocket. Unfortunately, it means the top and
bottom are exposed to shocks from items falling on
the drive, so you’ll have to use extra caution.

The PX-SP08U connects to your Linux machine
via USB. It uses USB 2.0 for maximum data trans-
fer speed, but it will work with the slower USB

1.1, if you’ve got time to kill while transferring
files. It’s worth noting that the drive doesn’t have
a spot for an external power adapter, so if your
notebook’s USB ports don’t deliver enough power,
you may want to try before you buy.

Plextor also offers a 120GB version (the 
PX-SP12U) for $260 US.

SEAGATE 160GB USB 2.0 PORTABLE HARD DRIVE

http://www.seagate.com
$379 US

At a glance, Seagate’s Portable Hard Drive line does-
n’t look that rugged, sporting an all-metal casing
and no obvious shock protection. All of that is 
hidden on the inside, however; the metal casing sur-
rounds a protective silicon layer that surrounds the
drive, allowing the drive to move around a bit inside
the casing without sustaining damage. Because the
hard metal exterior isn’t directly up against the drive
or the circuitry, it also provides an extra bit of protec-
tion if the drive gets hit directly on the side.

Though Seagate offers external portable drives

GGaaddggeett  GGuuyy::  SSttoorraaggee  oonn  tthhee  GGoo
Looking to add a little bit of hard disk breathing room or a portable backup device? The Gadget Guy
reviews some USB-based external hard drives. SEAN CARRUTHERS
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in a number of capacities, the 160GB is notable
because it’s the first drive of its size to use
Hitachi’s new perpendicular recording technology.
That allows a drive of a much higher capacity—in
this case, 160GB, which is 40GB larger than the
previous capacity champ. For the time being,
you’ll pay for the privilege of using that new,
high-capacity technology. (If a 100GB or 120GB
drive is enough for your needs, you can save quite
a bit of cash.)

One really nice feature with the Seagate porta-
bles—the USB cable has two ends instead of only
one. If your computer’s USB ports deliver enough
power, you can plug in the cable marked
Power+Data only; if you need a bit of a power
boost, you can plug in the second USB cable,
marked Power Only.

LACIE 120GB RUGGED ALL-TERRAIN HARD DRIVE

http://www.lacie.com
$299 US

Rubber baby buggy bumpers? No! Rubber hard drive
bumpers is what LaCie’s Rugged All-Terrain Hard
Drive has, in bright orange, no less. It also comes with
a scratch-resistant aluminum case that’s designed to
protect the top and bottom of the drive.

What really sells the drive is triple connectivity.
Not only can you connect it to your computer
using USB 2.0, but you also can hook it up via
FireWire 400 and FireWire 800, which means no
matter what type of notebook you’re using, you
should be able to get peppy data transfer.

The drive is also available in 80GB and 100GB
versions, and if you don’t really need FireWire 
connectivity, you can opt for the USB-only version,
which unfortunately comes only in an 80GB version.

If you’re really hungry for portable storage,
LaCie also offers the non-ruggedized Little Big
Disk, which comes with a whopping 320GB of
hard drive space onboard, and both USB 2.0 and
FireWire 400/800 interfaces. Be forewarned,
though, it sports a hefty $799 US price tag.�

Sean Carruthers is a freelance technology
journalist from Toronto. He spent six years
at Canada Computer Paper, first as
Products Editor at The Computer and later
at HUB Digital Living magazine. As a free-
lancer, he has written for the Globe and
Mail, http://globetechnology.com, HUB

Digital Living, Computer Dealer News, Homefront and CE-Biz.
Although a relative newbie with Linux (SUSE, thank you very
much), he has extensive experience with tech gadgets of all sorts
and is enjoying figuring out which ones are compatible with Linux.
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POCKET-SIZED STORAGE
If you don’t need
quite as much storage
as an external hard
drive can provide, but
you need more than
the typical USB mem-
ory drive comes with,

there’s one stop in between—the pocket drive.
Because these pocket drives use the same type of

microdrive found inside consumer-friendly gadgets
like the iPod Mini, they’re able to store up to 8GB on
a device that easily fits into the palm of your hand.
The downside is they’re slower than the full-sized
external drives, so they’re not a suitable choice for
any task that requires extended data streaming.

Pocket drives are available from manufacturers of
both hard drives and USB Flash memory drives, such
as Seagate, Western Digital, LaCie, Memorex,
Verbatim and more.

http://www.lacie.com
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Written in 1995 by British computer game developer Chris Sawyer, Transport
Tycoon Deluxe has thousands of fans around the world to this day. Although
the game’s development ceased a long time ago, Transport Tycoon Deluxe
continues to live and evolve through OpenTTD (http://www.openttd.org), an
open-source version of the original game. OpenTTD takes over where
Transport Tycoon Deluxe left off and adds a wealth of improvements and
new features, including bigger maps, new and significantly improved artificial
intelligence (AI), support for more than 24 languages, a reworked airport 
system, an autorail build tool, improved terraforming and even a dubious
ability to bribe the town authority. These are only a few picks from the
steadily growing list of OpenTTD’s new features and improvements.

OpenTTD’s game play remains the same though. It’s 1950, you have
$100,000 in your pocket, and you’ve got 100 years to build a prosperous
transport company. To achieve this ambitious goal, you build roads, railways,
airports and ports that you use to move goods, mail and passengers to earn
money. As the years go by and the money starts rolling in, you can buy
faster vehicles, bigger airplanes and ships. Building a successful company also
means dealing with competitors and local authorities, and OpenTTD gives
you an opportunity to play against other players or its own AI engine.

OpenTTD requires some data files from the original game, so you must
have a copy of Transport Tycoon Deluxe either on diskettes or CD-ROM. The
good news is that you can buy a copy of the game cheaply on eBay. Like any
Linux application, OpenTTD can be installed in several ways:

� Your Linux distribution may include a packaged version of OpenTTD. In
this case, use your package management software to install the game.

� OpenTTD is available as Deb and RPM packages on the project’s
SourceForge page.

� You can download the source code and compile the game yourself, 
and OpenTTD’s wiki provides detailed instructions on how to do this
(http://wiki.openttd.org/index.php/Compiling_on_Linux).

Once OpenTTD is installed, you have to copy several original Transport
Tycoon Deluxe files into the /usr/share/games/openttd/data directory. You
need to copy the following files:

� Graphics: trg1r.grf, trgcr.grf, trghr.grf, trgir.grf and trgtr.grf.

� Sound: sample.cat.

� Music: all the *.gm files. Copy the music files into the gm folder. If the

OOppeennTTTTDD
Open source hauls the classic Transport Tycoon Delux game into the future.
DMITRY POPOV
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Figure 1. The opening dialog lets you choose the scenario you want to play
and change the game’s settings.
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folder doesn’t exist, create it in the /usr/share/games/openttd/ directory.

If you played Transport Tycoon Deluxe before, you’ll feel at home with
OpenTTD. For those who aren’t so lucky, the game can be a bit tricky to
come to grips with, and the lack of a coherent manual doesn’t make life 
easier for OpenTTD newbies. There is no reason to panic, however; the 
following description will get you started in no time.

The opening dialog window allows you to choose the game you want to
play. You have four options here: New Game, Load Game, Create Scenario
and Play Scenario. Let’s start from scratch and choose New Game, leaving
the other settings as they are. Click on the New Game button, select a sce-
nario from the list, for example Super Britania, and double-click on it. This
opens the main window with a map and a toolbar at the top. The next step
is to figure out where to start and what to build. Obviously, you should find
two places on the map that need to be connected and have something you
can transport between them to earn money. For example, a power station
requires coal, and you can build a road to the neighboring coal mine and
transport the coal using trucks. In this case, you have to locate both places
on the map. One way to do this is to click on the Industries button (the
one that looks like a factory), which displays a floating window containing
a list of all industrial locations on the map. Each item on the list contains
important information about its production capacity and percentage of the
transported goods.

For example, you can see that the Brinfield Coal Mine has 120 tons
of coal, and none of the produced coal has been transported. If you
double-click on the Brinfield Coal Mine, you’ll see its exact location on
the map. And, if you take a closer look at the map, you’ll see that the
mine is located not far from the Brinfield Power Station, which requires
coal to run. This means you can make some money by building a road
and transporting coal from the mine to the station. To build a road
between the mine and the station:

1. Press the Road button and select the appropriate road segment. Use
the mouse to place the road segment in the desired location.

2. Right-click to add the road segment to the map.

3. Repeat this step until the road is built.

4. Next, you have to add lorry (truck) stations at both ends. Click on the
Road button and select the lorry station with the appropriate orientation
(so that the station faces the road). Add one lorry station somewhere close
to the power station and another one next to the coal mine.

5. You also have to add a road depot to produce and maintain trucks. Again,
click the Road button, select the Road Depot (remember the correct orien-
tation) and place it on the road, for example, close to Brinfield.

6. Finally, you have to add a truck. Double-click on the road depot, and click
the New Vehicles button in the Brinfield Road Vehicle Depot. Select the
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Figure 2. The Industries window can help you find places that may need you.
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Balogh Coal Truck and press Build Vehicle. This places a new truck in the
Road Vehicle Depot and opens the Road Vehicle 1 window.

7. The very last thing you have to do is to specify orders for your truck.

In this case, you have to instruct it to pick up coal at the coal mine and
deliver the load to the power station. To do this:

1. Press the Orders button (it looks like a broken arrow) in the Road
Vehicle 1 window.

2. Press Go to.

3. Click on the lorry station next to the coal mine.

4. Then, press the Full load button.

5. Now, press the Go to button again.

6. Click on the lorry station next to the power station.

7. Press the Unload button.

8. In the Road Vehicle 1 window, press the Stopped button to get the truck
going, and you are done.

Note: this may all sound complicated, but once you’ve figured out the
basics, you easily can build more-complicated transport connections.

Of course, there is much more to the game, and you’ll undoubtedly figure
out most of OpenTTD’s features as you spend time building your transport
empire. The good thing is that you don’t have to play alone. OpenTTD sup-
ports muliplayer mode, and it can act as a server. To start your own OpenTTD
server, press the Multiplayer button in the Welcome dialog window, and
press Start server. Select the desired scenario, and press the Start Game
button. Now your friends and family members can join the fun.

OpenTTD comes with a limited selection of scenarios, but you can
build your own scenarios as well. You also can download and install 
scenarios available on the Web (http://easttown.co.uk/TTDX/index.php
and http://ttdscenarios.com/index.php are good places to start). Download 
the scenario you want, unzip it and place the scenario file into the
/usr/share/games/openttd/scenario directory.

Finally, a word of caution—OpenTTD can be very addictive, and once you
get started, it is difficult to stop. So, make sure you don’t have any deadlines
or homework looming before you start the game. And, don’t forget to join
the Transport Tycoon Forums (http://www.tt-forums.net) to meet OpenTTD
players and developers as well as to check out other people’s creations.�

Dmitri Popov is a freelance writer whose articles have appeared in Russian,
British and Danish computer magazines. His articles cover open-source
software, Linux, Web applications and other computer-related topics.
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Figure 3. Here is a truck transporting coal from the coal mine to the
power station.
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